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eCatalogs

Electronic product catalogs, also known as eCatalogs, are data files in STEP that contain product and price
information for a specific product selection, typically stored in a product collection.

eCatalog Elements

An eCatalog object consists of three elements:

« A collection of the products go into the eCatalog. A collection can be either dynamic or static.

« Aprice list, which contains the prices that are valid for the eCatalog. A price list consists of product with its
terms. A term for a product is a combination of a value and a set of conditions such as Minimum Quantity,
Maximum Quantity, Start Date, and End Date.

« AneCatalog configuration, which specifies the output format, the delivery method, and the mapping between
internal product attributes and the attributes of the export format.

--{]j GOSN Receiver
--{]j Merge_Golden_Foot
[#-{[7] Promotions
@ Publications
r_=| Primary Product Hierarchy
@ Collections
Eli eCatalogs
: - eCat
..[E] eCatalog Configuration

e eCat Prices
"2} Recyde Bin

eCatalog Price Lists and Commercial Data Lists

Price lists used in eCatalogs are identical in format to the price lists used for commercial data in STEP Publisher.
They contain the same elements (Value, Unit, Quantity, Dates), use the same default System Setup commercial
object type of Price (Price), and are mapped identically in the Import Manager. The difference between the two is
in their intended output. eCatalog price lists are intended for electronic output, and commercial data lists are strictly
used in STEP Publisher print publications.

Since eCatalog price list import configurations are mapped using commercial data options in the Import Manager,
the term 'commercial data' is frequently used in this guide to refer to the contents of eCatalog price lists. For more
information on commercial data, see the Commercial Data section of the STEP Publisher (InDesign)
documentation.
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Creating an eCatalog

To create a new eCatalog, follow these steps.

1. Inthe Tree, select eCatalogs.

2. Right-click and select New eCatalog.
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3. Inthe Create eCatalog dialog, enter an ID and Name for the eCatalog, then click Create.

3 Create eCatalog

D AcmePrices

Mame |Acme Prices

Create

Cancel

4. The eCatalog is created.
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The next steps are to add the following elements to your eCatalog:

« A price list that contains the prices that are valid for the eCatalog.
« A product collection that contains a list of all the products that go into the eCatalog.

« An eCatalog configuration that specifies the output format, the delivery method, and the mapping between
internal product attributes and the attributes of the export format.
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Creating a Price List

A price list consists of terms. A term for a product is a combination of a value (price) and a set of conditions such
as Minimum Quantity, Maximum Quantity, Start Date, and End Date.

The first step when setting up your eCatalog is to create a price list that holds the prices of the eCatalog.

1. Inthe Tree, select the eCatalog that you want to create a price list for.

2. Right-click, and then click New Price List.
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Note: The STEP object type used for eCatalog price lists, Price (Price), is the same default object type used
for Commercial Data price lists. If you are also using Commercial Data in your system, any configurations
made to the Price object type (e.g., setting an ID Pattern) will apply to eCatalog price lists. Additionally, the
eCatalog price list cannot have the same ID as a Commercial Data list that uses the Price object type. For
more information on Commercial Data, see the Commercial Data section of the STEP Publisher
(InDesign) documentation.

3. Inthe Create Price List dialog, enter an ID and a Name for the price list, then click Create.
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3 Create Price List

D AcmeSpringPrices

Marme |Acre Spring Prices

Create Cancel

4. Onthe Price List tab, the following optional settings are available.
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« Immutable: When checked, this setting prevents commercial data from being updated.

« Act as selection list: Enable this option to have the products included in the price list serve as the product
selection for the eCatalog. If a collection is added to the eCatalog, the collection serves as the product list, and
this option will be disabled. For more information on adding a collection to an eCatalog, see the Selecting
Products for eCatalogs topic.

« Import Configuration: Specifies the import configuration to be used for the price list. Click the ellipsis button (
[..]) to select the saved import configuration.

« Currency: Click the ellipsis button ((-..]) to choose a currency unit for the list. This selection can be any unit and

does not have to be currency.

Note: This does not place the unit on price lists values. To have the unit display within terms lists, the unit must
be added when defining the import configuration by mapping the values of an Excel column to the 'Unit' aspect
of the terms list. See Creating an eCatalog Configuration for more information on creating import
configurations.
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« Last modification time: Displays the date and time that the list was last modified. This field is non-editable.

« Expiry date: Enter an expiration date for the list, or double-click the field to open the Date Picker.

Note: The price list will not expire automatically. The date is for administrative purposes only and is not the
same as the 'End Date' value that can be defined for individual terms. See Creating an eCatalog
Configuration for more information on the 'End Date' value.

« Default Start-date and Default End-date: Like Expiry date, these values are for administrative purposes
only and are not the same as the 'Start Date' and 'End Date' values defined for individual terms.
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Defining Import Settings for Price Lists

eCatalog price list terms (commercial data) are imported into eCatalog price lists using standard Import Manager
functionality.

After creating a price list object for your eCatalog, the next steps are to create a sample import file, in Excel or CSV
format, then define the import settings for importing actual price data. The columns in the sample file will be used to
map fields in the Import Manager wizard, which will allow the system to later ingest a sheet that contains actual
data.

Sample Excel Price List Load File

The following two screenshots show examples of price list import files, one containing price break and quantity
information, and the other one containing price break, quantity, unit, start date, and end date information.

Price Example

This example sheet is an Excel file that contains 10 columns and 8 products. Each product has three prices with
price breaks that change based on the quantity of the product being sold.

For example, using the first product row shown in the below screenshot (ID = 121171), the price breaks are as
follows:

Break No. Quantity Price

1 1-3 2.79

2 4-9 1.79

3 10-100 0.89

i) B C N = E & H | |

1 _«::ID:=— Pricel Plmin Plmax Price 2 P2Zmin P2max Price3d P3min P3max
211121171 2.79 1 31.79 4 9 0.89 10 100
3 (121177 2.99 1 3 2.49 4 9 0.99 10 100
4 121178 2.89 1 31.89 4 9 0.99 10 100
5 121179 3.99 1 3279 4 90.79 10 100
6 121184 1.99 1 30.79 4 9 0.49 10 100
7 1121192 17.76 1 39.70 4 9 5.76 10 100
8 121193 7.29 1 3549 4 9 2.99 10 100
9 121150 9.99 1 3 5.99 4 9 2.99 10 100
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Note: Even if you only wish to import a price file with three prices, you must set the Minimum and Maximum
values (even if they are fake values) to each of the prices. You cannot just load three columns of prices and
nothing else. So if you want to load three price breaks, you need to load nine columns of data. Unit, Start Date,
and End Date are optional.

Prices with Units and Dates

To also import Unit, Start Date, and End Date values, which are optional, a corresponding column for each value
must also be present on the sheet. In the below example—which shows columns for 'Price1' only—there is a
'P1Unit,' 'P1StartDate,' and 'P1EndDate’ column. Each subsequent price (Price2, Price 3, et al.) will also have its
own unit, start date, and end date columns.

Note: When importing units, the STEP ID of the unit must be used and not the symbol. In the below example,
is04217.unit.USD is the STEP ID for U.S. dollar ($).

A B C D E F G
1 <ID>  Pricel]P1Unit Plmin Plmax| P15StartDate P1lEndDate
2 121171 2.79 isod217.unit.UsD 1 3 9/1/2019 10/31/2019
3 121177 2,99 isod217.unit.UsD 1 3 9/1/2019 10/31/2019
4 (121178 2.89 isod217.unit.UsD 1 3 9/1/2019 10/31/2019
5 (121179 3.99 iso4217.unit.UsD 1 3 9/1/2019 10/31/2019
6 121184  1.99 isod217.unit.UsD 1 3 9/1/2019 10/31/2019
7 121192 17.76 isod4217.unit.UsD 1 3 9/1/2019 10/31/2019
8 (121193  7.29 isod217.unit.UsD 1 3 9/1/2019 10/31/2019
9 (121190  9.99 iso4217.unit.UsD 1 3 9/1/2019 10/31/2019

Creating an Import Configuration for a Price List

The following steps for creating a price listimport configuration use a sheet that contains columns for all available
price list (commercial terms) elements: value, unit, quantities, and dates. These steps assume that you have
already created a sample file. Throughout the Import Manager, the elements within the price list (terms) are
referred to as commercial data.

1. Inthe Tree, expand the relevant eCatalog.

2. Select and right-click the price list that you want to import prices to, and then click Edit import configuration.
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Tree
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. The Import Manager displays on the Select Data Source screen.

Note: All steps of the Import Manager wizard, and the options available for each step, are described in detail
in the Creating a Data Import section of the Data Exchange documentation. The information in this topic
only contains detailed descriptions of the steps that are of particular importance to commercial data.

4. Onthis screen, select File. The data source will always be File for commercial data import configurations.

. While still on the Select Data Source screen, click the ellipsis button ([...)) next to the Filename field and
choose the sample upload file, then click Next.

. Onthe Select Format screen, the format will be prepopulated with either Excel or CSV, depending on the
format of your sample sheet.

. Make any additional configurations (‘Has Header,' "Trim whitespace,' 'Use date and number formatting from
sheet'), then click Next.

Note: Itis strongly recommended to keep the default selection of no for Use date and number formatting
from sheet, especially if importing date values. This ensures that date values are standardized into an ISO
format. See the Excel Format section of the Import Manager documentation for more information.
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Steps

Select Format

1, Gelect Configuration
2. Select Data Source
3. Select Format

4, Map Data

5, Identify Objects

6. Identify Destination
7. Select Business Rules
8. Advanced Settings

Format | Excel

Converter for files in Microsoft Excel format that contain one object per row,

Has Header
Trim whitespace

IUse date and number formatting from sheet

yes

yes

no

Conversion Preview:

<D= * |Pricel > [P1lnit P 1min P Imax » |P1StartDate » P1EndDate * |Price2
121171 2,79 s04217.unit... |1 3 20190901 |2019-10-31  [1.79
121177 2,99 'sa421?.unit... 1 3 2019-09-01  |2019-10-31  2.49
121173 2,89 'sa421?.unit... 1 3 2019-09-01  |2019-10-31  [1.89
121174 3.99 'sa421?.unit... 1 3 2019-09-01  |2019-10-31  2.79
121134 1.99 'sa421?.unit... 1 3 2019-09-01  |2019-10-31  0.79
121192 17.76 'sa421?.unit... 1 3 2019-09-01  |2019-10-31  9.76
121133 7,29 'sa421?.unit... 1 3 20190901 |2019-10-31  5.49
121190 2.99 'sa421?.unit... 1 3 20190901 |2019-10-31  5.99
£ >
Back Mext Finish Cancel

Mapping Commercial Data in the 'Map Data' Step

In the Map Data step, a number of mappings must be specified manually. The 'Auto Map' feature will not work for
commercial data mappings, though it can be used to map the ID or Name columns. ID is required.

1. To start the mappings, click a source column, then click Map. The Map Column to dialog displays.

Select the column to map, then click Map. The Map to dialog displays.

In this example, the first column has already been mapped to ID; the first price column, 'Price1," has been
selected; and the Commercial Data radio button has been selected in the Map to dialog.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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E! mport Manage >
Steps Map Data
1. 5elect Configuration Source:
2. Select Data Source =ID= >| Price1 > I:-1|_|nit » [P 1min > [P iman > P1StartDa &
3. Select Format 121171 7 L 1 3 9;1;19
4. Map Data 121177 2,99 e
’ 121178 239 & Ma, Pricel to
5. Identify Objects .
121179 3.99
: - D
6. Identify Destination T T )
7. Select Business Rules 171192 17.76
) (") Name
8. Advanced Settings <
Result: (O Attribute
[D=<ID> -~ (® Commerdial Data
121171
121177 () Product Classification Link Dataset [Spring]
121178 () Product Reference Group 1
121179
171134 () Asset Reference (@) Value
121152 () Classification Reference (O Unit
Auto Map Map!
(") Entity Reference () Min, Quantity
| (T Reference Meta-Data () Max. Quantity
(") Parent () Start Date
(7 Object Type (") End Date
(") Variable
() Multivalued Variable
(") Overrides product

(") Add child to override

[ Mandatory

Cancel 0K

The name of the price list will display in the Data Set field.

From the Group list, select the preferred quantity break.

Choose one of the following options to determine which field of the commercial list that the data from the Excel
sheet should be mapped to:

« Select Value to map the column to the value field.

Select Unit to map the column to the unit field and have the unit display along with the term value.

Select Min. Quantity to map the column to minimum quantity in the selected group or price break.

« Select Max. Quantity to map the column to maximum quantity in the selected group or price break.
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« Select Start Date to map the column to the start date when the price becomes valid.

« Select End Date to map the column to the end date of the selected group or price break.

Check the Mandatory box if you want rows without a term value to be skipped on import so none of the
information that may be related to a product without a specified term value will be imported. Click OK.

Follow the previous steps until all columns of the sheet are mapped. For example, in this sheet, after mapping
the 'Price1' column to Commercial Data > Group: 1 > Value, the remaining columns will be mapped as follows:

o The'P1min' column will be mapped to Commercial Data > Group: 1 > Min. Quantity

« The'P1max’ column will be mapped to Commercial Data > Group: 1 > Max Quanity

o The 'P1Unit' column will be mapped to Commercial Data > Group: 1 > Unit

o The'P1StartDate’ column will be mapped to Commercial Data > Group: 1 > Start Date
« The'P1EndDate' column will be mapped to Commercial Data > Group: 1 > End Date

o The 'Price2' column will be mapped to Commercial Data > Group: 2 > Value, and so forth.

The remainder of the columns will follow the same pattern. Click Next when finished.

Completing the Import Configuration

1.

On the Identify Objects screen, if the products in the source file are not identified as existing products in the
system, the 'Match Result' will be 'New.' Click Next.

On the Identify Destination screen, several options are available, which are detailed at length in the Import
Manager - Identify Destination topic in the Import Manager documentation. For the purposes of
commercial data imports:

« Reject Updates should be left unchecked, since a setting on the Advanced Settings screen of the wizard
will control how commercial lists are updated.
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2 Import Manager

Steps Identify Destination

1. Select Configuration
2. Select Data Source Approver User 4 (IUSER4)
3. Select Format :

Import Workspace Main v
4, Map Data
5. Identify Objects Default Parent Primary Product Hierarchy (Product hierarchy 1||...
6. Identify Destination Default Chject Type: | Frimary Froduct Classification
7. Select Business Rules Batch Directory (Mone) Reset
8. Advanced Settings

Test Only Import ]

Feject Mew ]

Reject Updates ]

Back Mext Finish Cancel
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2. Onthe Select Business Rules screen, business rules can be specified to run upon import if required for your
business needs. For more details, see the Import Manager - Select Business Rules topic in the Import
Manager documentation. Click Next.

3. Onthe Advanced Settings screen, any options can be selected based on your business needs, but the only

options relevant to commercial data appear in the Replace/Update Options area.

» Todelete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

« To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, select Only update commercial data for objects included in import file.

For more information on all options available on the Advanced Settings screen, see the Import Manager -
Advanced Settings topic in the Data Exchange documentation.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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32 Import Manager

Steps Advanced Settings
1. Select Configuration Context English US <
2. Select Data Source
Import Process Template: Impaorter
3. Select Format
4, Map Data Match Units By Name I
5. Identify Objects Approve Import Changes |

6. Identify Destination
7. Select Business Rules

Auto-Initiate STEP Workflows on Item Creation

Trigger STEP Workflow import events on Item Updates [ ]

8. Advanced Settings
Suppress Re-Translations
Auto select Import Mode (O]
Force Database Import 9]
Force Domain Import 9]
Replace/Update Options Replace/Update Terms

() Replace entire existing list{s) with content of import file

(®) Only update commerdial data for objects induded in import file

Remove Options rRemove Un-Mapped Values v

Back Mext

3. Click Finish to complete the wizard. The Save Import Configuration dialog displays. It is recommended to
save the import configuration and check 'Don'timport now' in case changes need to be made to the
configuration before importing live data. Click OK.

See the Running a Data Import topic in the Data Exchange documentation for information on how to save
the import configuration.

$2 Save Import Configuration

Save Options

Save to Funﬁguraﬁunsﬂmpﬁrt Configurations /AcmePrices

O Start Import Process: Importing

() Import now

Cancel

4. The price listimport configuration is saved in the specified classification structure as an XML file of the object
type Import Manager Configuration (stibo.ImportManagerConfig).

5. Aprice list can now be imported. See the next section of this topic, Importing Prices, for details.
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Editing a Saved eCatalog Import Configuration

To make changes to an existing eCatalog import configuration, do the following.

1. Right-click on the price list and select Edit import configuration.

w-{[] GDSN Receiver

Tree
[+ ] GOSN -~

<

e ot [
=

[+-{] Merge_Golden_Root ?
t-{[] Promotions Mame ¥
=- [l Publications s ID

@ Templates > Name

&Il AutoPage Publications _

[l Standard Publications > Object Type

@ Flatplanner Publications * Immutable

- [l Spring Wedding Catalog * |Act as selection list
[H-{[T] Primary Product Hierarchy :
EEI--@ Collections * Impart Configuration
- eCatalogs Import Data

=l Acme Prices Edit import configuration I

(- eCat Copy Ctrl+C
|:E|i;I RECE'CIE Bin % Cut Chrl+X

> Delete

2. The Import Manager wizard displays, starting on the Select Data Source screen.
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3. Make the desired edits following the same steps listed above for creating a new configuration.

4. Alternatively, you can edit the configuration by right-clicking on the saved import configuration object in the
classification hierarchy. See the Maintaining a Saved Import Configuration topic in the Data Exchange

documentation for details.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)
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eCatalog price lists are imported using standard Import Manager functionality. In STEP Workbench, these imports
can be initiated from STEP Workbench menu (i.e., File > Import > Data) or from the price list object itself. This
topic explains how to import commercial data information for eCatalog price lists through a right-click action on the

price list object.

To import eCatalog price information:

1. Right-click on the price list object and select Import Data.

Tree
[+ 7] Web Sites US

@ Company Higrarchy Data Root
@ Customer Root

- £ Entity Root

(0] GDSN

-] GDSN Receiver

{E| Merge_Golden_Root

[#-{[] Promotions

@ Publications

r_=| Primary Product Hierarchy

<

e ot [
-

?

Mame

* D

» Marme

* [Object Type

* [Immutable

* |Act as selection list

@ Collections
-l eCatalogs

Import Data

Edit import configuration

Copy Ctrl+C
Cut Ctrl+X
Delete

2. Inthe Import Commercial Data dialog, click the ellipsis button (E]) next to Filename, then navigate to and

select the file you want to import.

Note: This file must match the format of the file saved in the import configuration.
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8 Import Commercial Data

Filename C:\Users\user\Documents | Commerdal Data\ChmmData 3Breaks. xsx
(@) Start background process | Importing Three Breaks

() Import on-ine

Replace JUpdate Terms

() Replace entire existing list{s) with content of import file

{®) Only update commerdal data for objects induded in import file

Cancel

3. Inthe Replace/Update Terms area, select one of the following options:

« Todelete all existing content of the commercial list(s) and replace it with the content of the new file, select
Replace entire existing list(s) with content of import file.

« To keep the existing content of the commercial list(s) and only replace the commercial data of the product
IDs included in the new file, select Only update commercial data for objects included in import file.

The choice you made when defining the import configuration on the Advanced Settings screen of the Import
Manager wizard will be set as default, but you can override this option by selecting the other option.

Note: If Inmutable has been checked on the price list object, values cannot be updated regardless of what
option is chosen. See Creating a Price List for more information.

4. Select Import on-line option if you want the process to run and show the result online instead of going to a
background process. Once the process completes, the Import Report window will show the complete report.

5. Click OK.

To view the imported data, use one of the methods outlined in the Viewing Price Lists topic.
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After importing a price list, the commercial data terms can be viewed both from the price list and from the
product that is included in the list. Additionally, the data can be searched when viewing it from the product.

View Terms from a

Price list

1. Navigate to and select the relevant price list in your eCatalog.

2. Onthe Price List tab, expand the Content of area.

3. The contents of the price list are displayed.

Tree

r_=| Assets
r_=| Bulk Update Configurations
r_=| Classifications

r_=| Configurations

--E, Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

B[ UNSPSC-CODE

-] Web Sites US

#-{[] Company Hierarchy Data Ro
{E| Customer Root
=) Entity Root

{0 GDSN

-] GDSN Receiver
{E Merge_Golden_Root
-] Promotions

@ Publications

r_=| Primary Product Hierarchy
@ Collections

]

Acme Spring Prices - Price List

Product

Showing 24 terms, There are terms for & different products,

EI‘ eCatalogs
- = Acme Prices i
- 45 Acme Spring Prices

i B eCat
=1 Recyde Bin

Search Terms from a Price list

1. Navigate to and select the relevant price list in your eCatalog.

2. Select the relevant commercial list, then click the Price List tab.

3. Expand the Content of area to view the content of the list.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

Product ¥ [Value * [Unit ¥ [Min Quantity
* Pink & Green Party Hat 2.79 |$ﬁsn421?.unit.L.lSD} 1
» Pink & Green Party Hat 1.79 |$ﬁsu421?.unit.L.l5D} 4
» Pink & Green Party Hat 0.89 |$ﬁsu421?.unit.L.l5D} .10
» Cosmic Party Hat 2.99 |$ﬁsu421?.unit.U5D} il
* [Cosmic Party Hat 2.49 |$ﬁsn421?.unit.L.lSD} 4
» [Cosmic Party Hat 0.99 |$ﬁsu421?.unit.L.l5D} .10
* Purple & White Party Hat  [2.89 |$ﬁsu421?.unit.L.l5D} 1
* Purple &White Party Hat (1.9 |$ﬁsu421?.unit.U5D} .
* Purple & White Party Hat 0,99 |$ﬁsn421?.unit.L.lSD} .10
» [fellow & Pink Party Hat 3.99 |$ﬁsu421?.unit.L.l5D} 1
» [fellow & Pink Party Hat 2.79 |$ﬁsu421?.unit.L.l5D} 4
» Wellow & Pink Party Hat n.79 |$ﬁsu421?.unit.U5D} ..||10
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4.

In the Product field, enter a product name or ID, or use an asterisk to enter part of a name or ID, and then click

Search.

StiboSystems
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[ price st [
== Description

| Product |Pink™® Search
Showing 24 terms. There are terms for & different products.
Product » [value > [Unit » [Min Quantity > [Max Quantity * |Start Date

* Pink & Green Party Hat 279 |$ (izo4217.unit.UsSD) |...|[1 3 2019-09-01 00:00:00
* Pink & Green Party Hat 1.79 |$ ({iso4217.unit. UsD) |...|4 9 2019-09-01 00:00:00
* Pink & Green Party Hat n.83 |$ (iso4217.unit.UsSD) |...|[10 100 2019-09-01 00:00:00
* Cosmic Party Hat 2,99 |$ﬁsu421?.unit.U5D} it 3 2019-09-01 00:00:00
» Cosmic Party Hat 2,99 |$ﬁsn421?.unit.USD} .3 2019-09-01 00:00:00
* Cosmic Party Hat 0.99 |$ﬁsu421?.unit.U5D} .10 100 2019-09-01 00:00:00
* Purple & White Party Hat  [2.89 |$ﬁsn421?.unit.USD} .1 3 2019-09-01 00:00:00
* Purple & White Party Hat  [1.89 |$ﬁsu421?.unit.U5D} .|t 2019-09-01 00:00:00
» Purple & White Party Hat 0,99 |$ﬁsn421?.unit.USD} ..|[10 100 2019-09-01 00:00:00
» ffellow & Pink Party Hat 3.99 |$ﬁsu421?.unit.U5D} -1 3 2019-09-01 00:00:00
* [fellow & Pink Party Hat 2,79 |$ﬁsn421?.unit.USD} .|t 2019-09-01 00:00:00
* Nellow & Pink Party Hat 0,79 |$ﬁsu421?.unit.U5D} .10 100 2019-09-01 00:00:00
» Christmas Party Hat 1,99 |$ﬁsn421?.unit.USD} (i B 3 2019-09-01 00:00:00

5. The searchresults are displayed.

&= Description
@ Content of Price
Product |Pink] Search
Search result showing & terms, There are terms for 2 different products,
Product ¥ [Value > |Unit ¥ [Min Quantity * Max Quantii
* Pink & Green Party Hat 2,79 |$ﬁsu421?.unit.USD] (e 3
* Pink & Green Party Hat 1.79 |5ﬁsu421?.unit.U5D} .4 9
* Pink & Green Party Hat 0.89 |$ﬁsn421?.unit.L.l5D} .10 100
* Pink & Green Pom-Pom Hat [7.29 |$ﬁsu421?.unit.L.lSD} (i B 3
* Pink & Green Pom-Pom Hat  |5.49 |5ﬁsu421?.unit.USD] .14 9
* Pink & Green Pom-Pom Hat  [2.99 |5ﬁsu421?.unit.U5D} .10 100
> | Add Product

6. To show the entire content of the list again, leave the search field blank, then click Search.
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View Terms from a Product

1. Inthe Tree, navigate to and select the relevant product.

2. Onthe Commercial tab, expand the Terms area.

StiboSystems

MASTER DATA MANAGEMENT

3. Allprice lists that the product appears in are displayed. Any STEP Publisher commercial data lists that the
product is linked to will also display. For more information on commercial data, see the Commercial Data
section of the STEP Publisher (InDesign) documentation.

{1 Building Products
{71 Blectrical and Electronics

--F_=| Food and Beverage

--1'_=| Kitchen

=T Party Supplies

=[] Party Hats
=+{5) Paper Hats
- Balloon Hats

-] Pet Hats
[T Masks
[+-[T] Streamers

E

-] Wedding

Pink & Green Party Hat rev.0.7 - Commercial

TN EEIM | Tables || Category Profile || Proof View || Classification Rules || Status || State Log || Tasks

E}. Children's Hats

| Pink & Green Party Hat

- Purple & White Party Hz

[+-[T) Child Birthday Parties

Product Data Containers ” Sub Products ” References H Referenced By H Image
Terms List ID Terms List Name > Terms List Type * |Owner » [Owner Versions * Value »

» BpringPrices Spring Prices Price E] Spring Wedding Catalog  English US 279

» BpringPrices Spring Prices Price ﬁ] Spring Wedding Catalog Endlish US 1.79

» BpringPrices Spring Prices Price ﬁ] Spring Wedding Catalog Endlish US 0.89

*| eCatPrices eCat Prices Price _ eCat 313

*| eCatPrices eCat Prices Price eCat 2.99

» FrenchPrices French Prices Price Acme Party Supplies French FR. 3,99

* BummerPrices Summer Prices Price ﬁ] Summer Wedding Catalog 2.7

> BummerPrices Summer Prices Price E] Summer Wedding Catalog 179

» BummerPrices Summer Prices Price Summer Wedding Catalog 0.89
AcmeSpringPrices  \Acme Spring Prices  Price Acme Prices 2,79
AcmeSpringPrices  Acme Spring Prices  Price h Acme Prices 1.79
AcmeSpringPrices  Acme Spring Prices  Price _ Acme Prices 0.89

1Mwm

It is also possible to edit terms lists from both locations. See the next topic in this section, Editing Price Lists, for
more information.
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Editing Price Lists

After being imported, eCatalog price list terms can be edited, either from a price list or from a product.

Note: Price lists cannot be edited if the Immutable box has been checked on the price list object. See the
Creating a Price List topic for more information.

To Edit Price List Terms from a Price List

There are two ways to edit price list terms from a price list. The Value and Unit can be edited directly from the list.
The Value, Min Quantity, Max Quantity, Start Date, and End Date values can be edited by right-clickingon a
product in the list and accessing the Edit Terms dialog.

Editing Terms Directly
1. Navigate to and select the relevant price list, then click on the Price List tab.
. Expand the Content of section to view the content of the list.

2
3. Double-click in any Value field to edit the value.
4. Click the ellipsis button (....]) in the Unit field to edit the unit.

Editing Terms from the Edit Terms Dialog

1. Navigate to and select the relevant price list, then click on the Price List tab.
2. Expand the Content of section to view the content of the list.
3. Right-click the right arrow next to the preferred term, then choose Edit Term.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019) 23



StiboSystems

MASTER DATA MANAGEMENT
| Price List [JfE
2= Description
2 Content of Price
Product
Showing 24 terms. There are terms for & different products.
Product ¥ [Value > Unit
* Pink & Green Party Hat 2.79 |$ (is04217.un
> Pink & Green Party Hat 1.79 |$ (iso4217.un
> aq |$ (is04217.un
W Hide |$ (is04217.un
¥ Show All Columns |$ﬁsu421?.un
4 Rotate Table |$ (is04217.un
k Add Product Ctrl+Plus |$ (is04217.un
] Remove Product  Ctrl+Minus |$ (iso4217.un
_? Edit Term |$ﬁsu421?.un
3’—I'|''.:rr|wv||'-||:v.-|—n'r|'r|—|:1-|::|- T e |$ (iso4217.un

4. Inthe Edit Terms dialog, double-click inside the field for the term that you want to edit, then click OK when
complete.

$% Edit Terms for product "Pink & Green Party Hat" and terms list "Spring Prices".

Value > [Min Quantity » [Max Quantity » |Start Date » [End Date
¥ 279 1 3 2019-03-01 00:00:00 2019-10-31 00:00:00
* [1.79 v 9 2019-09-01 00:00:00 2019-10-31 00:00:00
* 0,89 10 100 2019-09-01 00:00:00 2019-10-31 00:00:00
* |Add Term
oK Cancel

Add Terms to a Price List

1. Follow the steps outlined above to access the Edit Terms dialog.
2. Click Add Term to add a new row to the Edit Terms dialog.
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3% Edit Terms for product "Cosmic Party Hat" and terms list "Spring Prices".
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Value * [Min Quantity » Max Quantity » |Start Date » [End Date
¥ 2,49 = 9 2019-09-01 00:00:00 2019-10-31 00:00:00
* 10,99 110 100 2019-09-01 00:00:00 2019-10-31 00:00:00
’ e
* | Add Term

Ok Cancel

3. Enter the relevant term values in the new row, then click OK.

Remove Terms from a Price List

1. Follow the steps outlined above to access the Edit Terms dialog.

2. Inthe Edit Terms dialog, right-click the arrow next to the term you want to remove, then choose Remove

Term.

$3 Edit Terms for product "Cosmic Party Hat" and terms list "Spring Prices".

Value » Min Quantity > |Max Quantity > |Start Date » |[End Date
> [2.49 4 q 2019-09-01 00:00:00  [2019-10-31 00:00:00
s 10,99 10 100 2019-09-01 00:00:00  [2019-10-31 00:00:00
| ’; | Hide v
Show All Rows
0K Cancel
Rotate Table
Add Term Ctrl+Plus
L IHemoveTerm CtrI+Mir1us|
Add Products to a Price List
Instead of importing products into a price list, you can add products manually, for which you then can edit the
terms.
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1. Navigate to and select the relevant price list, then click on the Price List tab.

2. Expand the Content of section to view the content of the list.

3. Right-click the menu icon (arrow) next to one of the terms in the table, and then click Add Product.
Alternatively, scroll to the bottom of the table-based view, then click Add Product.

[ Price List |[JIRY
& Descripi
2 Content of Price
Product
Showing 24 terms. There are terms for & different products.
Product * [Value » [Unit
* Pink & Green Party Hat 2.79 |$ (is04217.un
* Pink & Green Party Hat 1.79 |$ (iso4217.un
» & Green Party Hat n.89 |$ (iso4217.un
> Hide |$ (is04217.un
¥ Show All Columns |$ﬁsu421?.un
E Rotate Table |$ (iso4217.un
7 |Add Product Ctrl+Plus | § (s04217.un
7 Remowve Product  Ctrl+Minus |$ (=04217.un
' Edit Term $ (so217.un
* e == I$ﬁsu421?.un

4. Inthe Add Product to Terms List dialog, click the ellipsis button ([...]) .

3 Add Product to Terme List

Steps Select Product
1. select Product Select Product To Add To The Terms List
2. Enter Terms
Back Mext Finish Cancel

5. Browse to or search for the relevant product on the Select Product dialog, then click Select. Only one product
can be selected; an option to multi-select products is not available.

6. After selecting the product, click Next on the Add Product to Terms list dialog.
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7. Inthe Add Product to Terms List dialog, click Add Term to add a new blank row to the dialog.

8. Enter the relevant terms, then click Add Term again to add more terms.

Note: No option is available in this dialog to add a Unit. It must be added after the product is added to the list.

9. Click Finish. The product is now available in the list.

Remove Products from a Price List

1. Follow the same initial steps as above for adding a product, but click Remove Product instead of Add
Product.

2. The Remove Terms for dialog displays, showing all the terms that will be affected.

3. Click Delete to remove the product from the list.

3% Remove Terms for product "Purple & White Party Hat" and terms list "Acme Spring Prices".

Value ¥ [Min Quantity ¥ [Max Quantity » [Start Date * |End Date »
> &g 1 3 2015-09-01 00:00:00 2019-10-31 00:00:00
> 139 4 q 2019-03-01 00:00:00 2019-10-31 00:00:00
s 10,99 10 100 2018-09-01 00:00:00 2019-10-31 00:00:00

Cance

4. Click the ellipsis button (....]), then either browse or search for a Product, and then click Next.

5. Click Add Term and fill in the relevant fields.
6. Click Finish.

To Edit Price List Terms from a Product

Price lists can also be edited from product objects that appear in at least one price list. When viewing terms lists for
a product on the Commercial tab, the Value and Unit can be edited directly. The Value, Min Quantity, Max
Quantity, Start Date, and End Date values can be edited by right-clicking on a terms list and accessing the Edit
Terms dialog.

Editing Price Commercial Data Directly
In the Tree, navigate to and select the relevant product.
On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.

Double-click in any Value field to edit the value.
Click the ellipsis button ((-..]) in the Unit field to edit the unit.

Ao bd =
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Editing Commercial Data from the Edit Terms Dialog

1. Inthe Tree, navigate to and select the relevant product.
2. Onthe Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.

3. Right-click the right arrow next to the relevant term, then choose Edit Term.

[ Tables " Category Profile " Proof View ” Classification R
Product [ Data Containers ” Sub Products ” Re
9 Terms
Terms List ID > [Terms List Mame > [Terms List Type
» SpringPrices Spring Prices Price
> SpringPrices Spring Prices Price
> _RorinaPrices Sorina Prices Price
» Hide Sales Prices
> Show All Columns finter Retail PricPrice
» Rotate Table Due Cover Design Due
3 Add Term Ctrl+Plus Price
» Remove Term Ctrl+Minus  qce Prices Clearance Prices
> Edit Term Price
* Spring_Prices Spring Prices Price

4. Inthe Edit Terms dialog, double-click inside the field for the term that you want to edit, then click OK when
complete.

Add Terms to a Product

Terms can be added to a product from the Edit Terms dialog, or from the Add Term to Product dialog. Follow
these steps to add a term from the 'Add Term to Product' dialog.

1. Inthe Tree, navigate to and select the relevant product.

2. Onthe Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.

3. Clickthe Add Term link at the bottom of the list. Or, right-click on the right arrow next to any term and select
Add Term.

4. Inthe Add Term to Product dialog, click the ellipsis button ([.-.)).
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3 Add Term to Product

Steps Select Terms List
1. Select Terms List Select Terms List To Add To The Product
2. Enter Terms

Back Mext

Finish

Cancel
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5. Inthe Select Terms List dialog, browse to or search for the relevant commercial list, then click Select to close

the dialog.

3 Select Termc List

| Search

[+-{[] Customer Root

[+l Entity Root

{0 GDSN

[#1-{[] GDSN Receiver

{E Merge_Golden_Root

[#1-{[] Promotions

Eli eCatalogs

. [ Acme Prices
E}i eCat

e ﬁ =Cat Prices
[=1-{Fl Publications

& Detailz

Select

{E Company Hierarchy Data Root

----- eCatalog Configuration

Cancel

6. Click Next to go to the Enter Terms screen, then click Add Term to add a new row under Enter Terms.
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3 Add Term to Product

Steps Enter Terms
1. Select Terms List Value * [Min Quantity * [Max
2. Enter Terms s [2.79 1 3
» 1,79 4 £
> 0,89 10 100

| O ——

> | Add Term

* Fi

Back Mext Finish Cancel

7. Enter the relevant terms, then click Finish.

Remove a Single Term from a Product

1. Follow the steps outlined above to access the Edit Terms dialog.
2. Right-click the right arrow next to the preferred term, then choose Remove Term.

Remove All Terms from a Product
Removing all terms from a product will remove the product itself from the terms list.

In the Tree, navigate to and select the relevant product.
On the Commercial tab, expand the Terms area. The content of the lists related to the product is displayed.

Right-click the right arrow next to the relevant term, then click Remove Term.

The Remove terms for product dialog displays.

Verify that you want to remove the listed terms, then click Delete. All the product terms are removed, and the
product itself is also removed from the list.

o 0 Np =
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Copying Price Lists

You can make a copy of a price list and use it as a price list in a different publication. You can also copy price lists to
STEP Publisher publications to use as commercial data lists. For more information on Commercial Data, see the
Commercial Data section of the STEP Publisher (InDesign) documentation.

1. Navigate to the price list that you want to copy, then right-click and choose Copy.

—
. A[] Customer Root

- ‘F= Entity Root

(] GDSN

-] GDSN Receiver

{E| Merge_Golden_Root
#-f[] Promotions

@ Publications

r_=| Primary Product Hierarchy
@ Collections

Eli eCatalogs Import Data

: E}- Acme Prices Edit import configuration

- ﬁmw
I-ECat

-5 Recyde Bin

E'- Content of Price

Copy Ctrl+C
Cut Ctrl+X

34 iy

¥ Delete

2. Navigate to and select the eCatalog that you want to copy the list to, then right-click and choose Paste.

@ Customer Root
-2 Entity Root
(] GDSN
&[] GDSM Re
{E Merge_G
@ Promatio

<
[ <cotoios TS
—

Mew eCatalog
Mew Price List

Create Collection From File...

-1 Publicatic : :
1j Primary Mew eCatalog Configuration
B Collectio Mew List z
= __E;ai:f Copy Ctri+C
5. 3 ocut Cirl+X
[ Paste Ctrl+V
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3. Ifthe eCatalog already has a list, a warning dialog will display to let you know that the existing price list will be
deleted when you paste the new one. Click OK to continue and overwrite the price list, or click Cancel to exit.

32 The eCatalog Already Has a Price List

The eCatalog already has a price list, Do you want to delete the existing price list?

Cancel

4. Ifthe eCatalog does not already have a list, the Duplicate dialog displays.

5. Enter an ID and Name for the new list, then check the Duplicate terms box if you want to copy the actual
contents of the list.

82 Duplicate

ID SummerPrices
Mame |Summer Prices

Duplicate terms

Cancel

6. Click OK. The copied terms list is now present in the eCatalog.

[+#-{[] Customer Root

- £ Entity Root

(0] GDSN

-] GDSN Receiver

@ Merge_Golden_Root

&[] Promotions

@ Publications

r_=| Primary Product Hierarchy

@ Collections

Eli eCatalogs

: [+ Acme Prices
E}i eCat

{21 eCatalog Configuration
5% Recyde Bin
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Selecting Products for eCatalogs

There are two methods of selecting the products that should be part of an eCatalog. One way is to use the
contents of the price list itself, which is achieved by selecting the Act as selection list on the price list. See the
Creating a Price List topic for more information.

The second method is to link a collection to your eCatalog. In the workbench, collections can be created in two
ways:

1. Using the Search tab, perform a search, and create a collection of the results. This creates a dynamic product
selection for the catalog that can later be refreshed.

2. Using an import file, create a collection of the contents. This creates a static product selection for the catalog.
If you later want to alter the product selection, you will have to delete this file-created collection and create a
new one.

For information on how to create a collection using either method, see the Creating Collections topicin the
Getting Started / Super User Guide documentation.

Note: Itis strongly recommended to use a collection created from a search, since this collection can be refreshed
every time the eCatalog is exported. For more information, see the Selecting Products for eCatalogs topic.

This topic explains how to add collections to eCatalogs.

Add a Dynamic Collection to an eCatalog Through Search

To add a dynamic collection to an eCatalog created from a search:

1. Onthe Search tab, search to locate the products that you want to be part of the eCatalog.

2. When the search is complete, click the 'Save as Collection' button B .
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3.

u |Search: *hat =]
= " Object Type = EW
= Product -
=

% JER Reset

ame
GRAY HAT [ = 208511

w Gray Top Hat D = 137535

L m Industrial Hard Hat /D = 151195

I Pink & Blue Giraffe Party Hat [0 = 121155
m Pink & Blue Owl Party Hat ID = 121215

L m Pink & Green Party Hat D = 121171

L m Pink & Green Pom-Pom Hat 1D = 121795

I Purple & White Party Hat I = 13894

I Purple & White Party Hat 10 = 121175

I Red Hat 1D = 102305

w Red Top Hat ID = 132457

* i 5ki Hat ID = 1795357
* i Yellow & Pink Party Hat 1D = 12717%

< >

Displaying 29 of 29 results Show Details

- Jperations on Entire Result

B

Worlkflow " Bookmarks ” Syskem Setup ” BG Processes (4) ]

o
Ll
—

Ready ‘\

StiboSystems

MASTER DATA MANAGEMENT

Inthe Save as Collection in Background Process dialog, browse or search for the eCatalog that you want

to add the collection to.
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Save as Collection in Background Process

Search

15 Collections
E|- eCatalogs
[+ 5 Acme Prices
--- eCat

- Details

Collection ID 259773

Collection Mame Hat Collection
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4. Forthe Collection Name parameter, add a Name for the new collection (IDs are autogenerated).

5. Abackground process launches. When complete, the collection is added to the eCatalog.

[+-{] GDSN

-] GDSN Receiver
@ Merge_Golden_Root
#-f] Promotions

@ Publications

-1 Collections
-l eCatalogs

E} Acme Prices

—l

- [ Hat Collection

- - eCat
-5 Recyde Bin

(- {13 Primary Product Hierarchy

Acme Spring Prices

Add a Static Collection to an eCatalog Through a File

To add a static collection to an eCatalog created from a file:

1. Right-click on your eCatalog and select Create Collection from File.

© Stibo Systems - Confidential - STEP 9.1-MP6 (July 2019)

35



2.

({7 Company Hierarchy Data Root
[+-{[] Customer Root
[+l Entity Root

>
-~

+-{] GDSN
-] GDSN Rey BB

[+-{] Merge_G
(-] Promotio &

Mew eCatalog

Mew Price List

Create Collection From File...

&Il Publicati . _
r_=| Primary f Mew eCatalog Configuration
@ Collection Mew List 3

-8 eCatalog

: - Acrpf Copy Cut+€
=-pEeCat 38 Cut Ctrl+X

; . § F‘E Paste Ctrl+W

ﬁ Recyde Export eCatalog

Inthe Create Collection From File dialog, locate the file to be imported.

22 Create Collection From File

Look in: Imparts e ? - "

xi D Product IDs

Recent [tems

Desktop

Documents

2

This PC

@ File name:

Metwark: Files of type: | All Files

Product IDs. twt

v
Collection ID 112706

Collection Mame |Mew Products

File Contains Products e

Classifications

JAcsets
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3. For the Collection Name parameter, add a Name for the new collection (IDs are autogenerated).
4. Forthe File Contains parameter, select if the import file contains IDs of products, classifications, or assets.

5. Click OK to start a background process which will create the new collection.
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Creating an eCatalog Configuration

Another required step in creating an eCatalog is to add an eCatalog Configuration. This is an export
configuration that specifies the data to be included in the eCatalog, as well as the data format of the eCatalog.

To create and configure an eCatalog Configuration:

1. Navigate to the relevant eCatalog, then right-click and select New eCatalog Configuration.

--{]j Company Hierarchy Data Root "~
[+-{[] Customer Root
-2 Entity Roat Bl MNew eCatalog

-0 GDSN Mew Price List
{]j GDSM Receiver 8
#-{] Merge_Golden_F
--{]j Promotions
--@ Publications Mew List 5
r_=| Primary Produ

Create Collection From File...

[E Mew eCatalog Configuration

i Collections Copy Ctrl+C

E“ eCatalogs % Cut Ctrl+X
"i il Paste Ctrl+V
-5 eCat

-1 Recyde Bin Export eCatalog

2. The Configure eCatalog wizard displays on the Select Format screen. The Configure eCatalog wizard is
based on the Export Manager with added functionality, allowing you to map the prices from the price list
information of the current eCatalog into the selected output format. You can choose among the following
eCatalog formats, which are supported via export options:

« Excel: See the Excel Format section of the Data Exchange documentation for more information.

« BMEcat 1.2: An XML-based standard for electronic data transfer by electronic catalogs. See the BMEcat
Format section of the Data Exchange documentation for more information.

« Ariba CIF 3.0: A simple comma-delimited list of catalog items and their attributes. See the Ariba CIF 3.0
Format section of the Data Exchange documentation for more information.

o cXML.: Exports data using Ariba cXML 1.2 and is an XML-based language designed specifically for
communication of e-commerce business documents. See the cXML Format section of the Data Exchange
documentation for more information.

« XCBL: exports data using the CommerceOne XML-based language. See the xCBL Format section of the
Data Exchange documentation for more information.
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Configure an eCatalog Configuration for Excel

1. Select Excel from the dropdown list on the Select Format screen of the Configure eCatalog wizard, then click
Next.

2. Onthe Map Data screen, click on the relevant information that you want included in the export (for instance,
<ID>), then click the arrow button in the right part of the window to add it to the list of data to be exported. Ata
minimum, you must map ID and a price column. Name is also recommended.

3. Tomap the price data, expand Commercial (eCatalog). Select the relevant price list (in this example, 'Price'),
then click the arrow icon to add it as a column in the Excel sheet.

32 Configure eCatalog Acme Prices

Steps Map Data

1. SelectConfigurstion, [ <I0= Exports data in Excel format.
2, SelectObjects. | i <Mame =

3. SelectFormat | L. <Parent ID= [»| | Column (2 mapped)

4.MapData | <Object Type Name = & <10 ID |
c Advanced | - <Product-Override Child ID= .
6. Select Delivery Method | <[z deleted =

----- "Constant Value™
----- <Page Mumber =
~Gelect Attribute
[H-Classifications

- Index Words
[-Product Classification Linkg
[+-Product References
E
£
£
[

- 2Name = || ||

+-fAzzet References
+-Classification Referegh
+-Entity References
+-STEP Workflow TgEk Info

]

..Cu i
--System Setup

Inherit Data and References

Back Mext Finish Cancel

4. Inthe Enter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then click Save.
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33 Enter Quantity Break

Enter quantity break value
1

Save Cancel

5. The price value is mapped, followed by the break number in brackets, e.g., [1].

m % Column (3 mapped)
@ <ID>1ID > .

B <MName = |

ST L

6. If youwould like to apply transformations to the values that display in the export, click the 'flipper' icon next to
Price to view the fields that have the transformation icon (| &+ ) available. When mapping a commercial value,

you have the same transformations available as you would have for a product attribute, but the available
aspects differ.

For more information on applying aspect transformations to outbound data, see the Aspect - Transform
Outbound topicin the Data Exchange documentation. For a broader overview on applying transformations
to outbound data, see the Outbound Map Data - Transform topic in the Data Exchange documentation.

| |¥ Column (3 mapped)
@ <D= ID 7| .
&= <Name = | e
2 Price [1] |l 4
[ Header | "Price in SpringPrices” G
|} Value | Price [1] % x

7. Click the transformation icon (/&= ) next to the Header field to change the header that will display in the Excel

export spreadsheet for the price value. In the Transformations dialog, enter the desired header in the Source
field, then click Save.
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¥ Transformations

Target: Header

SOUrCE: |Price in SpringPrices - Break 1

Save Cancel

Note: If the header is not changed, then the header in the Excel sheet will be the same for all price breaks,
e.g., 'Price in SpringPrices.' As such, it is recommended to customize the header for each break, for example,
'Price in SpringPrices - Break 1.’

8. Click the transformation icon (/& ) next to the Value field if you want to apply a transformation to the values that
display in the price columns. If changing the aspect, the following selections are available:

o Price - default; the value field from the commercial list

o Currency - the unit from the commercial list

« Price and currency - both the value and the unit from the commercial list
o Currency ID - the ID of the unit from the commercial list

« Min Quantity - the Min. Quantity value from the commercial list

« Max Quantity - the Max. Quantity value from the commercial list

« Start Date - the Start Date value from the commercial list

« End Date - the End Date value from the commercial list

¥ Transformations

Target: Value

Source: Price [1]

Aspect: | price “
T R - |
Currency

Price and currency

Currency ID

Min Quantity

Max Quantity

Start Date

End Date LY

Add Transformation

Save Reset Cancel

9. Repeat the process to map values from additional price breaks. The following screenshot shows a sample
mapping with ID, Name, and three price breaks with transformations applied:
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|> 2 Column (5 mapped)
- <D= ID

b
€

@ <MName:>

@ PriceAndCurrency [1]

[* Header "Price in SpringPrices - Break 17 &

|> Value PriceAndCurrency [1] %‘

@ PriceandCurrency [2]

|> Header | "Price in SpringPrices - Break 27 %'

|> Value |PriceAndCurrency [2] '@:-'

@ PriceAndCurrency [3]

[+ Header "Price in SpringPrices - Break 3" &

81 e 8
b
€

|> Value PriceAndCurrency [3] %

10. Click Next on the Map Data screen when finished.

11. Onthe Advanced screen, additional options specific to eCatalog exports are included in addition to the options
available in the standard Export Manager. For information on the standard options available on this screen, see
the Export Manager - Advanced section of the Data Exchange documentation. The additional options for
eCatalogs are highlighted in the below screenshot.
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$3 Configure eCatalog Acme Prices

Steps Advanced

1, Select Configuration

[] Tag conversion Coupan
2, Select Objects

[] Locale conversion from context

3. Select Format

4, Map Data Resolve Inline References

5. Advanced () Export Only Lacal Inline References
6. Select Delivery Method (®) Export Inherited Inline References

Indude Calculated Attribute Values

Warkspace |Main e
Context |English LIS e
Use effective date

(®) Current date of when export is initiated

(O) Effective Date: |2018-07-26 | ...

[ ] selfcontained references

Back Finish Cancel

« Use effective date: Select this option if you want the system to take the 'start date' and 'end date' specified
on the price list into consideration when exporting prices. 'Use effective date' ensures that prices will only be
included in the export if the effective date lies within the specified period. Leave this box unselected to have
the system disregard the 'start date' and 'end date' applied to products on the price list.

If selected, then specify one of the following options:

« Select Current date of when export is initiated to ensure that the prices included in the export have
a start date that occurs on or before the date that the export is initiated. If the start date of a price on the
price occurs after the current date, then that price will not be included, since it is not yet valid.

« Select Effective to ensure that the prices included in the export have a start date that occurs on or
before the date specified. As with the 'current date' option, if the start date of a price on the price list
occurs after the effective date, it will not be included in the export.

If no date span has been specified for the prices, the effective date will have no effect.

« Selfcontained references: Select this option if there is a need for the export to be self-contained. This
ensures that no references will be allowed to point to anything outside of the export.
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8. Click Next to advance to the Select Delivery Method screen.
9. Select File, then click Finish.

Configure an eCatalog Configuration for BMEcat

This section describes how to configure information specific to eCatalogs when using the BMEcat format for your
eCatalog Configuration. For full details on how to configure the rest of the information required for a BMEcat
export, see the BMEcat Format section of the Data Exchange documentation.

1. Select BMEcat from the dropdown list on the Select Format screen of the Configure eCatalog wizard.

2. Fillout any relevant fields on the screen, then click Next.

3. Onthe Map Data screen, the following mandatory fields are marked in red text with an asterisk: Supplier
Article ID, Short Description, Order Unit, and Price. Since this guide concerns eCatalogs, the Price field will be
mapped.

4. To map the price data, expand Commercial (eCatalog). Select the relevant price list (in this example, 'Price'),
then click the arrow icon next to Price to add it as a column in the Excel sheet.
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8 Configure eCatalog Acme Prices

Steps Map Data
L SelectConfigration | <D= Converts data to a BMEcat 1.2 format (see www.bmecat.org).
2, GelectObjects | | i Name: .
3. SelectFormat | .. <Parent ID> [ |'? Artide Features (0 mapped) A
----- <Object Type Name =
oz Ject TYpe ?me , [ Order Unit * |Nothing mapped & |
5 Advaneed | i <Product-COverride Child ID=
6. Select Delivery Method |+ ::I 5 d'?:t:‘:l}l i [} Content Unit| Nothing mapped & %
----- onstant Value
----- <Page Mumber > |} Packing quantity| Mothing mapped '@? by
--Gelect Attribute
- Classifications |} Price Quantity Mothing mapped % by
[+-Index Words
Mini tity | Mothi d
[#-Product Classification Links |> inimuim Quantity Nothing mappe % X
#]-Product References [} Quantity Interval Mothing mapped '%' >
[+-Asset References
[#-Classification References |} Price start date Mothing mapped '%' by
[+-Entity References
[-STEP Workflow Task Info [ Price end date| Nothing mapped % X
--Multi level References
A i
-Multi level Parent attributes |> Daily Price? Nothing mapped % X
..... Insert Referenced Objects > |} |@ Price * (0 mapped)
=-Copmerdal (=Catalog
D/ [@ MIME Info (0 mapped)
"CUS lom Attributes [» |"$’ MIME Info {Catalog Group Assets) (0 mapped)
[-5ystem Setup _
‘--Attributes Inherited from Classification |> |EJ User Defined Extension (0 mapped)
[ |'? Article Reference (0 mapped)
< [ |"? Catalog Group Map (0 mapped) y
Inherit Data and References * =Mandatory field  Red = Unmapped mandatory field
Back Mext Finish Cancel

5. Inthe Enter Quantity Break dialog that displays, enter the quantity break value (e.g., 1), then click Save.

32 Enter Quantity Break

Enter quantity break value
1

Cancel

Save

6. The price value is mapped, followed by the break number in brackets, e.g., [1].
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[»||¥ Price = (1 mapped)
&= price [1] by

If you would like to apply transformations to the values that display in the export, click the 'flipper' icon next to
Price to view the fields that have the transformation icon (| ) available. When mapping a commercial value,

you have the same transformations available as you would have for a product attribute, but the available
aspects differ. The available aspects in the price transformations for the BMEcat format are the same as those
available for Excel exports. See the above subsection, 'Configure an eCatalog Configuration for Excel,' for
more information.

For more information on applying aspect transformations to outbound data, see the Aspect - Transform
Outbound topicin the Data Exchange documentation. For a broader overview on applying transformations
to outbound data, see the Outbound Map Data - Transform topic in the Data Exchange documentation.

Q@ Price * (1 mapped)
@ Price [1]

|> Type Price [1]

|> Amount = |Price [1]

|> Currency | Maothing mapped

|> Tax | Price [1]

|> Factar | Price [1]

|> Lower Bound | Price [1]

|| [ | [ || |||
NN L 4

|> Territory | Price [1]

Note: Commercial (eCatalog) > Price values can be mapped to other fields other than 'Price.' For example,
You could map to the 'Minimum Quantity' field, then apply an Aspect transformation to pull the '‘Min Value'
value from the price list.

Click Next on the Map Data screen when finished.

On the Advanced screen, additional options specific to eCatalog exports are included in addition to the options
available in the standard Export Manager. For information on the standard options available on this screen, see
the Export Manager - Advanced section of the Data Exchange documentation. The additional options for
eCatalogs are the same as those available for Excel exports (User effective date, etc.). See the above
subsection, 'Configure an eCatalog Configuration for Excel,' for more information.

8. Click Nextto advance to the Select Delivery Method screen.

9. Select File, then click Finish.
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Configuring eCatalog Configurations for Other Formats

The process for creating an eCatalog Configuration for other available formats (Ariba CIF 3.0, cXML, and xCBL)
is very similar to that for creating configurations for Excel and BMEcat exports. Though the available data fields
differ on the Map Data screen of the Configure eCatalog wizard for each format, the process for mapping
Commercial (eCatalog) > Price is the same, and the available aspects for transformations are the same.
Additionally, the same options (‘Use effective date,' etc.) are available on the Advanced screen.

Editing an Existing eCatalog Configuration

1. Toedit an existing eCatalog Configuration, right-click the configuration and select Edit.

Eli eCatalogs
E}i Acme Prices

------ [] eCatalog Configuration

----- Acme Spring Prices

. [#-[J) Hat Collection
(-8 eCat Copy Ctrl+C

-5 Recyde Bin 88 Cut  Ctrl+X
¥ Delete

2. The Configure eCatalog wizard displays. Follow the same steps as you would when creating a new
configuration.
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Exporting an eCatalog

1.

In the Tree, right-click the relevant eCatalog, then select Export eCatalog. The Export eCatalog wizard
displays on the Refresh Collection screen.

Select Refresh before each run if you want the collection to be refreshed before each export. This option is
only relevant for collections created from a search. It does not apply if your collection was created from a list or
if you are using the price list as the product selection.

$2 Export eCatalog - Acme Prices

Steps Refresh Collection
L. Select eCatslog Refresh before each ruri
2. Refresh Collection

3. Schedule Process

4. Mame Process

Back Mext Finish Cancel

On the Schedule Process screen, specify whether you want to export the eCatalog immediately or at a
specified time in the future, then click Next. You have the following options:

« Now: Starts the eCatalog Export process and delivers the eCatalog as specified in the eCatalog
Configuration.
« Later: Schedules a single delivery in the future at the specified time and date.

o Weekly: Schedules a recurring eCatalog export for one or more of the days of the week. This option
requires a time, a start date, and optionally an end date. If no end date is specified, the eCatalog scheduling
process runs until it is ended manually.

« Monthly: Schedules arecurring export of the eCatalog for a specific day of every month.

« Later and repeat: Schedules delivery in the future at the specified time and date and at an interval given in
minutes.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause confusion
about when the job will run since the scheduled time is not automatically converted to accommodate potential
differences in time zones.
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$3 Export eCatalog - Acme Prices

Steps Schedule Process
1, select eCatalog Start
2. Refresh Collection
(@) Mow
3. Schedule Process
4, Mame Process (O Later
() Weekly
() Monthly

() Later and repeat

Start now

Back Finish Cancel

4. Onthe Name Process, provide a name for the process. An auto-generated name is provided, but you can
change it to make it easier to identify the process.

o4 Export eCatalog - Acme Prices

Steps Name Process

1, select eCatalog
2. Refresh Collection
3. schedule Process

4. Name Process Mame: |Export eCatalog 'Acme Prices'

Badk Mext Cancel

5. Click Finish to either start the export process or a scheduling process, depending on the specified settings.
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